
 

Data Automation Manual, Centre for GeoSpatial Studies, The University of The West Indies 
 

1

Caribbean Planning for Adaptation to Global Climate Change 
Regional Project Implementation Unit 

Inventory of Coastal Resources and Uses Consultancy 
 
 

&RPSRQHQW�����
,QYHQWRU\�RI�&RDVWDO�5HVRXUFHV�DQG�8VHV�

�

$�*,6�EDVHG�'DWD�$XWRPDWLRQ�0DQXDO 
 
 

 
Alleyne Planning Associates Inc. 

BAMP Complex, Spring Garden Highway 
St. Michael, Barbados, West Indies 

 
In association with 

 
 

ESSA Technologies Ltd. 
Suite 301, 1595 16th Avenue 

Richmond Hill, Ontario, Canada 
L4B 3N9 

 
And 

 
Centre for Geospatial Studies 

The University of the West Indies 
St. Augustine, Trinidad and Tobago 

 
 
 
 

October 2000 



 

Data Automation Manual, Centre for GeoSpatial Studies, The University of The West Indies 
 

2

A MANUAL FOR DATA AUTOMATION 
 

Table of Contents 
 
 

1.0   SPATIAL DATA AUTOMATION USING ARCVIEW 3.2 TM  7 
                   

 
1.1 Heads-Up Digitizing …………………………………………  7 

1.1.1  Georeferencing of Scanned Maps……………………….. 7 

1.1.2   ArcView’s Interface…………………………………….. 10  

1.1.3   Adding a scanned image to a view ……………………..  11  

1.1.4   Setting your Working Directory ……………………….   12 

1.1.5   Setting a scale threshold………………………………… 12    

1.1.6   Digitizing a point theme ………………………………..  13  

1.1.7   Digitizing a line theme………………………………….. 16  

1.1.8 Digitizing a polygon theme ………………………….. 22 

1.1.9   Saving and opening your project ………………………. 24  

 

 
1.2 Heads-Down Digitizing…………………………………………… 25  

1.2.1 Requirements for digitizing…………………………….. 25 

1.2.2 Establishing coordinates of a coverage……………… … 25 

1.2.3 Map preparation………………………………………… 26 

1.2.4 The digitizing process…………………………………. . 26 

1.2.5 Setting up the digitizing tablet………………………….. 29 

1.2.6 Loading the digitizer extension in ArcView……………. 29 

1.2.7 Preparing the view for digitizing……………………….. 30 

1.2.8 Registering your map ………………………………….. 30 

1.2.9 Digitizing features from a paper map…………………... 31 

 
2.0 EDITING SPATIAL DATA USING ARCVIEW 3.2 TM   33 
 

2.1 Editing a Point Theme……………………………………… 33 



 

Data Automation Manual, Centre for GeoSpatial Studies, The University of The West Indies 
 

3

2.2 Editing a Line Theme……………………………………….. 34 

2.3 Editing a Polygon Theme…………………………………… 34 

 

3.0 HOT LINKING IMAGES IN ARCVIEW 3.2 TM …………..  36 
 

 
4.0 CREATING THEMES IN ARCVIEW 3.2   USING GPS DATA  39 

 
 
5.0   ATTRIBUTE DATA AUTOMATION USING MS ACCESS TM  41 

 
5.1 Creating a database…………………………………………………. 42 

 5.1.1 Creating a table..………………………………………….. 43 

5.1.2 Creating tables in Design View ………………………….. 43 

5.1.3 Adding records to a table…………………………………. 45 

5.2 Connecting ArcView 3.2 TM to an external database……………….. 45  

5.2.1 Project / Add Table Menu Option……………………………. 46 

5.2.2 SQL Connect Menu Option ………………………………….. 46  

5.2.3 Creating a Theme Table for Joining………………………….. 46  

5.2.4 Creating an SQL Connection………………………………… 47 

5.2.5 Joining Tables………………………………………………… 48 

        

6.0 DATA MANAGEMENT REQUIREMENTS IN GIS   50 

6.1 Data Identification and Evaluation…………………………………. 51 

6.1.1 Data Identification………………………………………… 51 

6.1.2 Database Content and Structure…………………………… 51 

6.1.3 Data sources………………………………………………... 52 

6.1.4 Data Collection Strategies………………………………….. 52 

6.2 Data Integration………………………………………………………. 52 

6.3 Data Classification and Codification…………………………………. 53 

6.4 Data Entry Management……………………………………………… 53 

 6.4.1 Spatial Data Entry Modes………………………………….. 53 

6.4.2 Attribute Data Entry Forms………………………………… 54 



 

Data Automation Manual, Centre for GeoSpatial Studies, The University of The West Indies 
 

4

6.5 Data Verification……………………………………………………… 54 

6.6 Standards………………………………………………………………. 55 

6.7 Quality Control………………………………………………………... 55 

6.8 Quality Assurance………………………………………………………55 

6.8.1 Manual Validation…………………………………………….55 

6.8.2 Automated Validation………………………………………... 56 

6.8.3 Field Verification…………………………………………….. 56 

6.8.4 Assessing Quality……………………………………………. 56 

 6.9 Data Storage and Retrieval……………………………………………. 57 

6.9.1 Storage Structure…………………………………………… 57 

6.9.2 Storage Media…………………………………………………57 

6.9.3 Data Retrieval…………………………………………………58 

6.10 Access Methods and Control………………………………………….58 

6.11 Updating and Maintenance Procedures………………………………..59 

6.12 Data Dissemination and Distribution………………………………….59 

6.13 Data Distribution Options……………………………………………..59 

6.14 Liability………………………………………………………………..60 

6.15 Data Ownership………………………………………………………..60 

6.16 Pricing………………………………………………………………….60 

 

References……………………………………………………………………….. 61 
 
 
Appendix…………………………………………………………………..  62 
 

Notes taken from on-line help function of ArcView 3.2 TM 

 
 



 

Data Automation Manual, Centre for GeoSpatial Studies, The University of The West Indies 
 

5

List of Figures          
 
Figure 1 ArcView’s Interface ………………….………………………. 10 

Figure 2 Interface for adding an image to a View…………………… ... 11 

Figure 3 Interface for setting a scale threshold………………………… 12 

Figure 4 Creating a new theme………………………………………… 13 

Figure 5 Selecting a feature type for a theme…………………………. 14 

Figure 6 Selecting the directory for storing the new theme ……….….. 14 

Figure 7 Point theme added to a new view with scanned map………… 15 

Figure 8 Adding attributes to an attribute table………………………. 16 

Figure 9 Dialogue box for the snapping environment……………….. .. 17 

Figure 10 Popup menu for mouse snapping environment ……………… 17 

Figure 11 Drawing tool palette for creating a line theme……………….. 19 

Figure 12 Adding the length field to a line theme………………………. 20 

Figure 13 Distances for length field calculated for each line segment….. 21 

Figure 14 The Drawing palette tool…………………………………….. 23 

Figure 15 A polygon feature created along with its attribute table……... 23 

Figure 16 Dialogue box for setting attribute update rules…………….. ... 35 

Figure 17 Defining a hot link in a theme’s attribute table……………… 37 

Figure 18 Setting up hot link properties………………………………… 38 

Figure 19 Image linked to location of feature…………………………… 38 

Figure 20 Dialogue box for adding a file to ArcView…………………… 39 

Figure 21 File Opened in Project Window………………………………. 40 

Figure 22 Dialogue box for Add Event Theme………………………….. 41 

Figure 23 A New Theme added from GPS data ………………………… 41 

Figure 24 Dialogue box for creating a new database in MS Access……... 43 

Figure 25 Designing a Table……………………………………………… 44 

Figure 26 Adding records to an MS Access table………………………… 45 

Figure 27 Commonly used data entry shortcut keys……………………… 45 

Figure 28 Project/Add Table Dialogue Box………………………………. 46 

Figure 29 An example of a Point Theme and Table………………………. 47 

Figure 30 SQL Query Dialogue Box……………………………………… 48 



 

Data Automation Manual, Centre for GeoSpatial Studies, The University of The West Indies 
 

6

Figure 31 Joining Tables………………………………………………… 48 

Figure 32 Joined Tables…………………………………………………. 49 

Figure 33 Components of a GIS…………………………………………. 50 

Figure 34 Database Development Plan…………………………………... 51



 

Data Automation Manual, Centre for GeoSpatial Studies, The University of The West Indies 
 

7

1.0 SPATIAL DATA AUTOMATION USING ARCVIEW 3.2TM 

 
ArcView3.2 allows one to create spatial data on-screen or from a digitizing tablet 
through heads-up or heads-down digitizing.  After digitizing a theme in ArcView 3.2, 
errors may be created and must be edited. This manual will cover the following topics: 
 

1) DIGITIZING IN ARCVIEW 3.2 
� Heads-up Digitizing 
� Heads-down Digitizing 

 
2) EDITING SAPTIAL DATA IN ARCVIEW 3.2 
3) HOTLINKING IMAGES IN ARCVIEW 3.2 
4) CREATING THEMES IN ARCVIEW 3.2 USING GPS DATA 
5) AUTOMATING ATTRIBUTE DATA USING MS ACCESS 

 
 
At the end of the training, participants should be able to:  

� Perform heads-up digitizing and editing of errors in ArcView 3.2 
� Perform heads-down digitizing and editing of errors in ArcView 3.2 
� Hot link images in ArcView 3.2 
� Create themes in ArcView 3.2 using GPS Data 
� Create, join and edit tables for attribute data of an existing theme in 

ArcView 3.2 
  

 
1.1 HEADS-UP DIGITIZING 
Heads-up digitizing is the process of creating spatial data on-screen, using scanned and 
georeferenced images or maps. 
 
1.1.1 Georeferencing of Scanned Maps 

Georeferencing is the provision of metric properties to raster imageries so that they can be 
used as maps. Digital Raster Graphics [DRG] refer to geographically referenced raster 
images or other graphics generated by scanning source documents. 
This requires geometric processing of the scanned raster image. 
 
A properly georeferenced image may be used for the following: 

• Distance and area calculations 
• Extraction of the coordinates of discrete points 
• Vectorization of thematic features 
• Overlaying of other digital vectors 
• Enhancing cartographic properties of features. 
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How images are registered to a map in ArcView (taken from ArcView 3.2 GIS manual). 
Images are stored as raster data, where each cell in the image has a row and column 
number. Shapefiles and ARC/INFO coverages are stored in real-world coordinates. In 
order to display images with coverages or shapefiles, it is necessary to establish an image-
to-world transformation that converts the image coordinates to real-world coordinates. 
This transformation information is typically stored with the image. Some image formats, 
such as ERDAS, IMAGINE, BSQ, BIL, BIP, GeoTIFF, and grids, store the 
georeferencing information in the header of the image file. ArcView uses this information 
if it is present. However, other image formats store this information in a separate ASCII 
file. This file is generally referred to as the world file, since it contains the real-world 
transformation information used by the image. World files can be created with any editor. 
They can also be created using ARC/INFO’s REGISTER command.  
 
World file naming conventions 
It is easy to identify the world file, which should accompany an image file: world files use 
the same name as the image, with a "w" appended. For example, the world file for the 
image file mytown.tiff would be called mytown.tiffw and the world file for redlands.rlc 
would be redlands.rlcw. For workspaces that must adhere to the 8.3 naming convention, 
the first and third characters of the image file’s suffix and a final "w" are used for the 
world file suffix. Therefore, if mytown.tif were in a an 8.3 format workspace, the world 
file would be mytown.tfw. If redlands.rlc was in an 8.3 format workspace, its world file 
would be redlands.rcw. 
 
For images that lack an extension, or have an extension that is shorter than three 
characters, the "w" is added to the end of the file name without altering it. Therefore the 
world file for the image file terrain would be terrainw; the world file for the image file 
floorpln.rs would be floorpln.rsw. 
 
Affine transformation 
Affine transformations involve the conversion of the image coordinate system to the world 
coordinate system using basic two-dimensional scale, rotation and shift parameters. 
·Transformation parameters are obtained for: 

• Image and ground coordinates for a known reference point (usually the top left 
corner of the image). 

• Image pixel size and corresponding ground surface pixel size (used as a scalar 
difference). 

• Rotation elements. 
 
How the georeferencing information is accessed 
The image-to-world transformation is accessed each time an image is displayed (e.g., 
when you pan or zoom). The transformation is calculated from one of the following 
sources, listed in order of priority: 

• the world file 
• the header file (if the image type supports one) 
• from the row/column information of the image (an identity transformation) 
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Because a world file has higher priority, you can override the header file transformation 
information by creating your own world file. 
 
World file contents 
The contents of the world file will look something like this: 
20.17541308822119 
0.00000000000000 
0.00000000000000 
-20.17541308822119 
424178.11472601280548 
4313415.90726399607956 
 
When this file is present, ArcView performs the image-to-world transformation. The 
image-to-world transformation is a six-parameter affine transformation, where the ground 
or real-world coordinates can be given in the form of: 
 

x1 = Ax + By + C 
y1 = Dx + Ey + F  where: 

 
• x1, y1 are the calculated ground coordinates of the pixel on the map 
• x, y are the corresponding column and row numbers of the pixels in the image 
• A, E are the x and y scales respectively; dimensions of a pixel are in map units in 

the x direction. 
• B, D are rotation terms  
• C, F are translation terms: x,y map coordinates for the centre of the upper left pixel 
1. The scale E is always negative of the y-scale. 
 

Note:  The y-scale (E) is negative because the origins of an image and a geographic 
coordinate system are different. The origin of an image is located in the upper-left corner, 
whereas the origin of the map coordinate system is located in the lower-left corner. Row 
values in the image increase from the origin downward, while y-coordinate values in the 
map increase from the origin upward. 
 
The transformation parameters are stored in the world file in this order: 
                  20.17541308822119 - A 
                   0.00000000000000 - D 
                   0.00000000000000 - B 
                 -20.17541308822119 - E 
              424178.11472601280548 - C 
             4313415.90726399607956 - F 
 
Note:    ArcView does not rotate, or warp, images. If your world file has non-zero rotation 
terms (D and B parameters), the image may change its position relative to vector data in 
the same view when you zoom or pan. Use the ARC/INFO RECTIFY command to 
properly rotate the image. 
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1.1.2 ArcView 3.2’s interface 
 
 

 
 

Figure 1.  ArcView’s interface 
 
ArcView’s application window contains a graphical interface (GUI) that allows you to 
move, resize, minimize and maximize the window. 
 
The Project window (with a .apr extension) shows the names of all documents in an 
ArcView project. 
 
The Document windows have their own interface for the information that you may wish 
to work with. 
 
The GUI has all the menus, buttons and tools for accessing the functionalities of 
ArcView.  The menu bar has pulldown menus that give you access to ArcView’s 
functionalities.  The button bar provides quick access to commonly used operations.  The 
tool bar contains the tools that perform operations that require you to use the mouse. 
 
The Status bar displays on-line description of the operation being performed by the 
menu, button or tool bars, when you place the cursor over a menu choice.  The status bar 
can also show measurements and a progress bar for lengthy operations. 
 
Tool tips appear over a button or tool when you place the cursor over it.   
 

Application window 

Menu bar
Button bar 

Tool bar 

Project 
window 

Status bar 

Document 
windows 

Graphical 
user interface 
(GUI) 
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Heads-up digitizing is done on screen using a scanned map, an aerial photograph or a 
satellite image that can be read by ArcView.   
 
ArcView reads the following image formats: 
� BSQ, BIL and BIP 
� ERDAS LAN and GIS 
� ERDAS IMAGINE  
� JPEG 
� BMP 
� Run-length compressed files 
� Sun raster files 
� TIFF, TIFF/LZW compressed, and GeoTIFF 
� Grid-cell data in ARC/INFO grid format 

 
1.1.3 Adding a scanned image to a view 
� Open a New View. 
� Click the Add Theme button. 
� Choose Image Data Source from the Data Source Types list. 
� Navigate to the directory that holds the image you want to add. 
� Double-click on the directory name to list the image data sources that the 

directory contains. 
� Double-click on the image you wish to add.   
� If there are many images that need to be added, select the first image and while 

holding the shift key, select the rest of the images to be added.  Click OK.  All 
the images that make up the composite are added to the view. 

� Click the check box next to the theme’s name in the view’s Table of Contents 
to draw the image. 

Figure 2.  Interface for adding an image to a View 
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1.1.4. Setting your working directory 
• Make the View window active by clicking on the bar at the top of the view 

window.  (The bar goes blue). 
• Go to File, select Set Working Directory. 
• A window appears for you to type in the pathname of the location for storing your 

work.e.g. c:/temp/yourname. 
 
This ensures that all work will be saved to this folder as a default. 
 
1.1.5. Setting a scale threshold 
Setting a scale threshold, allows you to set a range of scales for displaying a theme.  This 
is necessary when working with raster images, so that you do not zoom in too much to the 
extent where the grid cells become too large that it is difficult to recognize features. 
 
Should you want to display certain aspects of a theme’s properties when you zoom in to a 
larger scale, you type in that scale value in the Maximum Scale input box.  The theme 
will not be displayed when the scale denominator exceeds the maximum scale threshold. 
 
To set a scale threshold: 
• Go to Theme Properties. 
• Select the Display icon at the left of the window.  
 

          
  

Figure 3.  Interface for setting a scale threshold 
 
In the window that appears, for that theme you are working with, type in denominator 
values for the minimum and the maximum scales at which you wish to view the image.  
For instance, the minimum scale denominator threshold for the image can be 2500 and the 
maximum can be 25 000.  If you try to view the image beyond either of these ranges, it 
will not be possible to do so. 
 
• Click OK 
 

Display Icon 
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Spatial data in a view is organized as a collection of themes.  A theme is a set of 
geographic features that represent real-world geographic objects.  These geographic 
features have descriptive information called attributes. These attributes are stored in 
’Theme Attribute Tables’.   
 
Points, lines and polygons are features that represent real-world geographic objects.   
These are the features that you may wish to digitize on-screen, as a:  

I. Point theme 
II. Line theme  
III. Polygon theme. 

 
You may wish to create a new theme, or add a feature to an already existing theme. 
 
1.1.6 Digitizing a Point Theme 
 
Digitizing a point theme involves creating a point theme and adding attributes to the 
attribute table for the point theme created. 
 
Creating a new point theme 

� Choose New Theme from the View Menu. 

 
Figure 4.  Creating a New Theme 

 
� Select Point as the Feature type from the dropdown list in the dialogue 

box.  
� Click OK. 
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Figure 5.  Selecting a feature type for a theme  

 

 
Figure 6.  Selecting the directory for storing the new theme. 

 
� Specify the name and location of the new shapefile in which ArcView will 

store the data for the theme created, in the dialogue box that appears.   
 
A shapefile is a simple, non-topological format for storing the geometric location and 
attribute information of geographic features. 

 
� Click OK.  A new empty theme for your point features is added to the 

view.  
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� Click the Drawing tool palette from the Theme menu bar, and select the 
Point Tool.  

 
� Add points to the theme from the image by clicking the left mouse button 

on a location that you wish to represent as a point.   A symbol is drawn to 
represent the point feature. 

 
� Choose Stop Editing from the Theme menu bar when you no longer wish 

to add points. 
 

� Click Yes to save your point features. 

 
Figure 7.  Point Theme added to a new view with scanned map. 

 
Adding Attributes to Point Features 
 
When you create a new theme in ArcView, an attribute table is automatically created with 
it.  Each new point adds a new record to the table.  The two fields created automatically in 
the table are the Shape field for storing the feature type and the ID number of the feature.  
New fields can be added to the table to store any additional attribute data for the theme.   
 
� Choose Start Editing from the Theme menu bar.   A dashed line around the 

theme’s check box indicates that the theme is in edit mode.   
 
� Click the Open Theme Table button.  The attribute table of the theme you 

wish to edit appears in the view.   
 
� Choose Add Field from the Edit menu.   
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� In the Field Definition dialogue box,  
� enter the Name of the new field you want to create,  
� choose a field Type from Number, String, Boolean, Date 
� enter the field Width as a number to accommodate the field name given 
� enter a number for Decimal places, if required. 

 
� Click OK.  The new field is now added to the attribute table. 

 
Figure 8.  Adding attributes to an attribute table. 

 
� In View, use the Pointer tool to select the point for which you wish to add a value.   

Selection handles appear around the point in the view. 
� Click on the bar at the top of the attribute table to make the table active. (The bar 

turns blue when the table is active.)  The selected record in the attribute table is 
highlighted.   

� Click in the type field for that record with the Edit tool.  The cursor appears in that 
field. 

� Type in the value. 
� Go to Table, from the menu bar and select Stop Editing. 
� Say Yes to the save the edits.  The additional fields are stored in the table. 
 

1.1.7  Digitizing a Line theme 
Digitizing a line theme involves creating a line theme and adding attributes to the theme 
table. You must set a snap environment before you start adding lines.  
  
Setting the snapping environment 
To ensure that lines meet perfectly at intersections when you digitize, the snapping 
environment should be set.  When the snapping environment is set, ArcView moves the 
vertices or line segments of the new features you add to align with the vertices or line 
segments of other features that are within a specified distance, called the snap tolerance. 
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All line features coming together at an intersection will share the same endpoint.  This 
ensures that there will be no overshoots or undershoots.  There are two types of snapping 
environments:  
� The general snapping environment 
� The interactive snapping environment 

Both types of snapping environments can be set by either typing a value or by using the 
mouse. 
 
To set the general snapping environment by typing in a tolerance 
� Make the theme active in the view’s Table of Contents 
� Click the Theme Properties button. 
� Click the Editing icon in the dialogue box that appears to display the theme’s  

editing properties.  
� Click the General check box to turn this Snapping on 
� Type in a tolerance value in the tolerance field.  
� Click OK. 

 
Figure 9.  Dialogue box for the snapping environment. 

 
To set the general snapping environment with the mouse 
� In the view, hold down the right mouse button to display the popup menu. 

 
Figure 10.  Popup menu for setting the snapping environment with the mouse. 

 
� Choose Enable General Snapping from this menu. 
� Click the Snap tool palette. 
� Click the General Snap tool. 

Editing Icon 
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� In the view, click and drag out a circle to represent the tolerance distance.  The 
status bar shows the radius of the general snap tolerance. 

 
To set the interactive snapping environment by typing in a tolerance 
Interactive snapping allows better control of how features are snapped. You can control 
how each vertex you are adding, is snapped to existing lines in the theme.  You can choose 
one of the following snap rules from the popup menu while you are adding the feature: 

Snap to vertex: This snaps the next vertex to the nearest vertex in an existing line. 
Snap to boundary: This snaps the next vertex to the nearest line segment in an 
existing line or polygon boundary. 
Snap to Intersection: This snaps the next vertex to the nearest node common to 
two or more lines or polygons. 
Snap to Endpoint: This snaps the next vertex to the nearest endpoint of an 
existing line.  

   
� Make the edit theme active. 
� Click the Theme Properties button. 
� Click the Editing icon in the dialogue box to display the theme’s editing 

properties.  
� Click the Interactive check box to turn on the Interactive type of snapping.  
� Type a tolerance value in the tolerance field. 
� Click OK. 

 
 To set the interactive snapping environment with the mouse.  
� In the view, hold down the right mouse button to display the popup menu. 
� Choose Enable Interactive Snapping from this menu. 
� Click the Snap tool palette. 
� Click the Interactive Snap tool. 
� In the view, click and drag out a circle to represent the tolerance distance.  The 

status bar shows the radius of the general snap tolerance. 
 
Creating a new line theme. 
� Create a new view. 
� Choose New Theme from the View Menu. 
� Select Line as the Feature type from the dropdown list in the dialogue box.  
� Click OK. 
� Specify the name and location of the new shapefile in which ArcView will store 

the data for the theme created, in the dialogue box that appears.   
� Click the Drawing tool palette. 
� Select the Line tool. 
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Figure11.  Drawing tool palette for creating a line theme. 

 
� Click where you want to start in the view, then click each vertex along the line.  

Double-click the final vertex 
 
If you are in the Interactive snapping environment, choose one of the snapping options 
from the popup menu to control how the next vertex you add to the line will be snapped to 
existing lines in the theme.  
 
While you are creating a line, you can choose the Delete Last Point option from the popup 
menu to delete the last vertex added. Repeatedly choosing this option allows you to delete 
all the vertices back to the start point of the line. 
 
When you create a new line feature, a corresponding new record is automatically added to 
the theme’s feature attribute table. 
 
Creating a line feature that splits other lines it crosses. 
In drawing a new line that crosses another line, you may need to split the lines so that an 
intersection is created.   To do this: 
� Click the Drawing palette tool.  
� Select the Line Split tool from the menu.  
� In the view, click where you want the line to start.  
� Click each vertex and double-click the final vertex.  The line you draw must cross over 

another line for any new feature to be created.  Both the existing line and the new line 
are split into separate lines at the point where they cross. 

 
 
 

Drawing tool 
palette, with 

line tool 
selected 
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Adding attributes to line features. 
When you create a new theme in ArcView, an attribute table is automatically created with 
it.  Each new line adds a new record to the table.  The two fields automatically created in 
the table are the Shape field for storing the feature type and the ID number of the feature.  
New fields can be added to the table to store any additional attribute data for the theme.   
 
To add attributes to a line theme, follow the procedure for ’Adding attributes to a point 
theme’ in Section 1.1.5. 
 
To add a length field to a line theme’s attribute table. 
Open the attribute table of the line theme for which you want to calculate a length.  
 
� Choose Start Editing from the Edit menu. 
� Add a numeric field, Length, to the table. 
� Click on the Length field to select it. 
� Click on the Calculate button to display the Field Calculator dialog. 
� In the box labelled [Length] =, type in:  [Shape] . ReturnLength 
� Click OK. 
 

The length field will be automatically calculated in the line theme’s attribute table. 
The length value calculated will be in the same units as the data source theme. 

 
Figure 12.  Adding the Length field to a line theme. 
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Figure 13.  Distances for Length field calculated for each line segment. 

 
To update attributes when lines are spilt or merged 
When you split a line, you can specify how the attributes of the two new lines will be 
derived from the attributes of the original one.  This is done by setting attribute update 
rules. 
 
For a single type field in the attribute table, such as Length, depending on whether you 
split or merge the lines, you can choose one of the split rules, that is, the Merge or Union 
rules.  
 
Split rules: 

Blank: The value in both records will be blank. 
Copy: The original value will be assigned to both records (the default). 
Proportion: The values will be proportional to the length of the new lines. 
Shape Length: The values will be the length of the new lines (the default for 
fields called Length) 
 

Union rules: 
Blank: The value in the resulting record will be blank. 
Copy: The value in whichever record is first in the table will be assigned (the 
default). 
Proportion: The value will be proportional to the lengths of the merged lines. 
Add: The values will be added together in the resulting record. 
Average: The values will be averaged in the resulting record. 
Shape Length: The value will be the length of the new lines (the default for fields 
called Length). 
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To set the attribute update rules for a single field in a line theme’s attribute table. 
� Make the line theme active 
� Click on the Theme Properties button. 
� Click the Editing icon to the left in the dialogue box that appears to display the 

theme’s editing properties.  In the Attribute Updating panel, choose the field in 
the theme’s attribute table to which you want the rule to be applied. 

� Click the Single Field type button. 
� Choose either the Union rule or Split rule you want to be applied to the field 
� Click OK. 

 
 
1.1.8 Digitizing a Polygon theme 
Polygon features represent areas that have a common characteristic, such as forests, 
population, land use or soil types. 
 
Setting the snapping environment for polygon themes 
If you want to remove any gaps or overlaps created during the digitizing process, you will 
have to set the snapping environment. 
To get all the polygons you are creating to snap to other polygons automatically, within a 
specified tolerance, set the General snapping environment.   
 
However, for better control over how your polygon features get snapped, set the 
Interactive snapping environment.  With interactive snapping, you can control how each 
vertex along the boundary you are adding is snapped to the existing polygons in the 
theme.   
 
To do this, while you are adding your polygon boundary, click the right mouse button to 
display the popup menu.  Choose from the following options to control how the next 
vertex you add will be snapped to existing polygons: 
 
Snap to vertex: This snaps the next vertex to the nearest vertex in an existing polygon. 
 
Snap to boundary: This snaps the next vertex to the nearest line segment in an existing 
polygon. 
 
Snap to intersection: This snaps the next vertex to the nearest node common to two or 
more polygons. 
 
Refer to Section 1.1.7 for setting the snapping environment.  
 
Creating a new polygon theme 
� Create a new view. 
� Select New Theme for the View menu.  
� Select Polygon as the Feature type from the dropdown list in the dialog box that 

appears. 
� Click OK. 
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� Specify the name and location of the new shapefile in which the data for the new 
theme will be stored.  A new empty polygon theme is added to the view. 

� Choose Start Editing from the Theme menu. 
� Click the Drawing tool palette. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14. The Drawing palette tool. 
 
� Select the Polygon tool. 
� Click where you want to start the line for your polygon. 
� Click each vertex along the line. 
� Double-click the final vertex.  A polygon is created in your view. 
 

 
Figure 15.  A polygon feature created along with its attribute table. 

 

Rectangle tool 

Circle tool 

Polygon tool 

AutoComplete  
tool

Polygon Split 
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Adding attributes to polygon features. 
An attribute table is created automatically when a new polygon theme is created.  The two 
fields created are Shape and ID.  You can add an area or perimeter field to the table. 
 
To add an area or perimeter field to a polygon theme’s attribute table. 
Open the attribute table of the polygon theme for which you want to calculate an area or 
perimeter.  
� Choose Start Editing from the Edit menu. 
� Add a numeric field, Area, or Perimeter to the table. 

 
To calculate the Area field 
� Click on the Area field to select it. 
� Click on the Calculate button to display the Field Calculator dialog. 
� In the box labelled [Area] =, type in: 

[Shape] . ReturnArea 
� Click OK. 

 
To calculate the Perimeter field 
� Click on the Perimeter field to select it. 
� Click on the Calculate button to display the Field Calculator dialog. 
� In the box labelled [Perimeter] =, type in: 

[Shape] . ReturnLength 
� Click OK. 
 

The fields Area and Perimeter are automatically calculated for each record. 
 
 
1.1.9 Saving and opening your project  

From the menu bar,  
• Go to File, Save Project As. 

A window appears. 
• Name the project (.apr extension), and save it to your working directory. 

 
Opening up your project 
To continue working on your project should you exit ArcView,  

• Go to File, Open Project  
• Select the name of the project you saved previously from the Open Project 

window.  
• Click OK. 
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1.2 Heads-Down Digitizing 
Heads-down digitizing is process of capturing data from paper maps, in digital format. 
Digitizing of points, lines and polygons is done with the use of a pointing device and a 
digitizing tablet. 
 
1.2.1 Requirements for digitizing 
• The digitizing tablet – This is a board with a mesh of wires that define its coordinate 

system.  The density of the wires indicates how close the digitized points may be 
captured from the hard copy map. The mesh is normally about 0.002 in. apart. 

• The digitizing cursor - The cursor can be either a pen or a keypad with buttons that 
control the data input.  It is attached to the tablet and captures features from the map.  
Each time a user presses a button on the keypad, the coordinates of that location are 
recorded. 

• Digitizer coordinate system – The tablet has a rectangular coordinate system with the 
origin in its lower left corner. 

• Spatial data registration – This is done by the use of known ground control points or 
'tics' that are used to register the spatial location of the coverage to the location on the 
digitizer.  A correlation is made between each control point coordinate and its digitizer 
coordinate. 

 
1.2.2 Establishing coordinates of a coverage  
The coordinates of the control points determine the coordinates of the coverage. There are 
two systems for establishing the coordinates of coverage before digitizing begins.  These 
are the: 

 
Digitizer coordinate system 
In the digitizer coordinate system, control points are given coordinate values that are not 
tied to any real-world origin.  Coverages digitized in this system must be transformed into 
an established real-world coordinate system after the coverage is digitized.  
 
Advantage: a check plot can be created at the scale of the source map and laid over the 
original map to check for digitizing errors.  
 
Real-world coordinate system 
In the real-world coordinate system, control points are given coordinate values in a real-
world coordinate system.  The control points on the hard copy map are registered to the 
control points in the coverage.  All spatial data digitized are therefore assigned values in a 
real-world coordinate system (feet or metres).  Coordinate transformation takes place 
automatically as the data are digitized. 
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Advantages:    
� The user has the ability to digitize a new coverage using another coverage as a 

reference or background coverage in the same coordinate system. 
 
� A master control point coverage can be created for the entire project and the control 

points copied to each new coverage as they are digitized. 
 
Registration error 
Registration error is one that expresses the difference between the relative location of the 
input control points from source maps and the output control points in real-world 
coordinates.  Control point IDs are used to identify the control points to be compared.  The 
error is given as the Root Mean Square (RMS) error.  The input RMS error should be less 
than 0.003 inches, depending on the accuracy requirements for the project.  Four control 
points should be used to help determine the RMS. 
 
1.2.3 Map Preparation 
Before digitizing begins, you should prepare the paper map as follows: 

• Premark control points 
• Extract control point information as a table 
• Extend map boundaries 
• Extend internal lines beyond the new outer boundaries 
• Mark intersection of arcs 
• Insert nodes on long arcs 
• Indicate starting nodes on island polygon 
• Mark label points of polygons 
• Record production information of the source map 

 
After preparing the map as stated above, tape the paper map securely to the digitizing 
tablet. 
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Exercise 
The diagram below shows nine control points and their coordinates. Complete the control 
point table of the nine control points with their real-world coordinates given in Eastings 
and Northings. 
 
 
       1163 0000           1165 0000   1167 0000  
 150 0000   12                       13                 14 
 
   
  
  
  
  
  
  
  
  
120 0000      22             23     24 
 
 
 
 
 
 
 
 
 
 
  90 0000    32            33     34  
 
 
 

Control point IDs Easting ( X coordinate) Northing ( Y coordinate) 
12 11630000 1500000 
13   
14   
22   
23   
24   
32   
33   
34   

 
Control Point Table 
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1.2.4. The Digitizing Process 
 
Digitizing Arcs 
Drawing an arc is controlled by buttons on the digitizer keypad as shown in the diagram 
below. 

Methods of digitizing  
There are two methods of digitizing arcs.  These are spaghetti digitizing and discrete 
digitizing.  
 
Spaghetti digitizing 

• Digitizing arcs without placing nodes at intersections.   
• This method is fast.  However, it can lead to arc User-IDs that are not unique.   

Because arcs define polygons, polygon topology cannot be created if arcs cross 
without nodes at intersections. 

 
Discrete digitizing 

• Discrete digitizing involves explicitly placing nodes at intersections as you digitize.   
• It is slower than spaghetti because the user must identify and digitize each arc 

intersection. 
• Discrete digitizing produces unique IDs that are important if attributes will be assigned 

to arcs later. 
• If tolerances are properly set, discrete digitizing requires less post-digitizing 

processing than spaghetti digitizing. 
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2      Start or end node 
   Numbers 1 - 9  are arcs. 
 

1.2.5 Setting up the Digitizing tablet 
There must be a Win Tab compliant digitizer driver software installed in order to use a 
digitizing tablet with ArcView. The manual that came with the particular digitizer would 
tell you whether the drivers are present. After installing the driver software, use the Win 
tab manager setup program to configure the buttons of the tablet’s puck of pen. 

 
1.2.6 Loading the digitizer extension in ArcView. 
Assuming you have successfully configured the digitizing tablet, prepared the map in the 
manner suggested and taped the map to the tablet, you can now load the Digitizer 
Extension. 

 
To load the Digitizer extension 
• Make the Project window active. 
• Choose Extensions from the File menu. 
• Click the check box next to the Digitizer extension, in the Extensions dialogue box. 
• Click OK
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1.2.7 Preparing the view for digitizing 
 
� Create a new view 
� Specify the projection used by the paper map. 
 
1. Choose Properties, from the View menu. 
2. Click the Projection button, in the dialogue box that appears. 
3. Select, from the options listed, the projection properties to match those of the paper 

map. 
4. Click OK. 
5. Set the desired Map Units from the dropdown list (e.g. Metres). 
6. Click OK. 
 
 
1.2.8 Registering your map 
You need to tell ArcView the ground coordinates for the control points of your paper map. 
 
To register your paper map for the first time. 
1. Choose Digitizer Setup, from the View menu. 
2. Specify the level of error you would allow by entering a value in the Error Limit 

field.  The default value is 0.004 inches. 
3. If your view is projected, use the Units list in the Digitizer Setup dialogue to specify 

the units of the ground coordinates for the control points (E.g. Decimal degrees, 
metres or feet). 

4. Click the digitizer puck icon to activate the digitizer. 
5. Digitize the control points from the digitizing tablet, in the order of the points from 

your control point table, placing the crosshairs of the puck over the control points, as 
accurately as you can.  A record appears in the dialogue box for each point you 
digitize. 

6. Type in the actual ground coordinates for the control points in the X and Y Coordinate 
fields.  An asterisk  (*) appears next to the record indicating that the control point has 
been entered and its ground control coordinates are now known.   

7. Click Save to save the table of the actual ground coordinates. 
8. ArcView then generates a RMS error called Calculated Error. 
9. Click Register, if the Calculated Error is smaller than the Error Limit.  The paper map 

is now registered.   
10. If the Calculated Error is greater than the Error Limit,  
� Re-digitize the control points on the paper map 
� Re-enter the corresponding ground coordinates 
� Go to File, select Open and navigate to the directory where you saved the actual 

ground coordinates to bring them back into the coordinate table in Digitizer Setup. 
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� Select the first record, and click the puck icon and digitize the first control point.  
� Repeat for the other control points. 
� Click Register, if the Calculated Error is smaller than the Error Limit. 

 
1.2.9 Digitizing features from a paper map. 

Creating new Features in a project 

• From the Untitled window, click New 
• From the New View, set the projection of the paper map attached to the digitizer. 
• Register the map 
• Select View from the menu bar. 
• Select Properties. 
• Type in a name for the view e.g. houses. 
• Click OK 

 
Creating a View for point features 
• Select View and choose New Theme. 
• Choose point tool from the Drawing tool drop-down list. 
• Click OK 
• Navigate to your directory and Save the new theme. 

 
The new point will appear in the newly named view, with a default symbol and colour. 
The new point will also be in editing mode. We are not ready to edit the point. 
 

• Go the View menu and select Stop Editing, from Theme.  
• You would be prompted to stop editing,  
• Click Yes, to stop editing. 

 
Note: You can create all of your themes, then begin to digitize or create each theme, 
digitize it, and then move on to the next theme.  
 
Creating a View for line features  

• Select View and choose New Theme. 
• Choose line tool from the Drawing tool drop-down list. 
• Click OK. 
• Navigate to your directory and Save the new theme. 
• Go to View from the menu bar and select Properties 
• Type in a name of the view e.g. Roads. 
• Click OK 
• Navigate to your directory and Save the new theme 

The new line will appear in the newly named view, with a default symbol and colour. The 
new line will also be in editing mode. We are not ready to edit the line. 

• Go the View menu and select Stop Editing, from Theme.  
• You would be prompted to stop editing,  
• Click Yes, to Stop Editing. 
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Creating a View for polygon features  
• Select View from the menu bar 
• Choose New Theme 
• From the Drawing tool drop-down list, choose the Polygon tool. 
• Click OK 
• Navigate to your directory and Save the new theme 

 
The new polygon will appear in the newly named view, with a default symbol and colour. 
The new polygon will also be in editing mode. We are not ready to edit the polygon. 

• Go the View menu and select Stop Editing, from Theme.  
• You would be prompted to stop editing,  
• Click Yes, to Stop Editing. 

 
Digitizing Points 

1. Activate the point theme to be digitized 
2. Select the theme by checking the box next to the theme 
3. Select Theme from the View menu  
4. Choose Start editing 
5. From the view menu select Draw point button, because a point is being edited 
6. Activate the digitizer as puck command from the View menu view 
7. Go to the digitizer tablet, the puck should collaborate with the cursor on the 

screen and also with the map area. 
8. Put points for the features you wish to draw e.g. Houses 
If you no longer wish to add any more points,  

• Select Stop Editing from Theme menu in the View. 
• Click Yes to the save edits prompt. 

 
 Digitizing Lines  

1. Activate the line theme to be digitized. 
2. Select the theme by checking the box next to the theme. 
3. Select Theme from the View menu.  
4. Choose Start editing. 
5. From the view menu select Draw line button, because a line is being edited. 
6. Activate the digitizer as puck command from the View menu view. 
7. Go to the digitizer tablet. The puck should collaborate with the cursor on the 

screen and also with the map area. 
8. Now trace the line feature you are interested in, by clicking once with the 

appropriate key on the digitizer puck to start the line and again to change 
direction. 

9. Double click to end the line using the appropriate button on the digitizer puck. 
10. Sometimes lines need to be snapped.  You then need to use the general snapping 

command or the snap to vertex command from the view menu. Before this can 
be done, the snapping radius must be specified using the required snap tool 
command. 

11. Select Stop Editing from Theme menu in the View, after all lines are digitized 
and snapped. 
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12. Click Yes to the save edits prompt.  
13. The line is highlighted after you digitize.  
14. Click the Clear Select feature button to unselect it. 
 
Digitizing Polygons 

1. Activate the Polygon theme to be digitized 
2. Select the theme by checking the box next to the theme 
3. Select Theme from the View menu  
4. Choose Start editing 
5. Select the Draw Polygon button, from the view menu to edit a polygon. 
6. Activate the digitizer as puck command from the View menu view 
7. Go to the digitizer tablet. The puck should collaborate with the cursor on the 

screen and also with the map area. 
8. Now trace and put points or vertex around the polygon features on the map you 

are interested in. e.g. Houses, swamps, etc. 
9. Select Stop Editing from Theme menu in the View, after all lines are digitized 

and polygons closed. 
10. Click Yes to the save edits prompt.  
11. The polygon is highlighted after you digitize. Click the Clear Select feature 

button to unselect it. 
 
Editing/Cleaning data 
Usually as the map data is digitized to a project, the data clean up is done simultaneously 
once you have set the snapping environment. 
 

2.0. EDITING SPATIAL DATA USING ARCVIEW 3.2 

After creating a point, line or polygon feature, you may wish to move, delete or change 
the feature.  Features to be edited must be in a shapefile, ARC/INFO, or CAD format.  To 
edit a theme that is not in any of these formats, you need to convert the theme to a 
shapefile, add it to your view as a new theme, and then edit this new theme. 
 
To convert a theme to a shapefile 
� Make the theme active. 
� Choose Convert to Shapefile from the Theme menu 
� Specify a name and location for the new shapefile. 
� Click OK. 
� Add the shapefile as a theme to the view. 
 
 
2.1 Editing a point theme 
There are many ways to edit a point theme.  You can: 
� Delete point features 
� Cut and paste point features. 
� Move point features 
 
Please see Appendix I on how to perform these edits. 
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2.2 Editing a line theme 
You can edit a line theme in many ways.  You can: 
� Delete line features 
� Cut and paste line features. 
� Move line features 
� Resize line features 
� Reshape line features 
� Split line features 
� Merge line features 
 
Please see Appendix I on how to perform these edits. 
 
Editing attributes when lines are split or unioned 
You can: 
� Change the ID number for each line segment  
� Change or delete text in a record in a field.  
 
2.3. Editing a polygon theme 
In editing a polygon theme, you can: 
� Delete polygon features 
� Cut and paste polygon features. 
� Move polygon features 
� Resize polygon features 
� Reshape polygon features 
� Split polygon features 
� Merge polygon features 
� Create doughnut polygons 
� Remove area of overlap between polygons 
� Obtain the intersection of polygons. 
 
Please see Appendix I on how to perform these edits. 
 
Editing attributes when polygons are split or unioned 
You need to set attribute update rules to specify how data in a polygon attribute table are 
dealt with when you split polygons using the Polygon Split tool, or merge polygon 
features using the Union features option.  
 
For each field in a polygon theme’s attribute table, you can choose one of the following 
Split rules: 
 

Blank: The value in both records will be blank. 
Copy: The original value will be assigned to both records (the default). 
Shape Area: The values will be the area of the new polygons (the default for 
fields called Area) 
Shape Perimeter: The values will be the perimeter of the new polygons (the 
default for fields called Perimeter) 
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For each field in a polygon theme’s attribute table, you can choose one of the following 
Union rules: 
 

Blank: The value in the resulting record will be blank. 
Copy: The value in whichever record is first in the table will be assigned (the 
default). 
Proportion: The value will be proportional to the areas of the merged polygons. 
Add: The values will be added together in the resulting record. 
Average: The values will be averaged in the resulting record. 
Shape Area: The value will be the area of the new polygon (the default for fields 
called Area) 
Shape Perimeter: The value will be the perimeter of the new polygon (the 
default for fields called Perimeter) 

 
To set the attribute update rules for a field in a polygon theme’s attribute table. 
� Make the theme active 
� Click on the Theme Properties button 
� Click the Editing icon to display the theme’s attribute table to which you want to 

apply the rule. 
� Choose the Union rule you wish to apply to the field 
� Choose the Split rule you wish to apply to the field.  
� Click OK. 

 
Figure 16.  Dialogue box for setting attribute update rules. 

 
� Choose Start Editing from the Theme menu.  A dashed line will appear around a 

theme’s check box in the Table of Contents to indicate the theme is now in edit mode. 
You can only edit one theme at a time in the view. 

 
To save your edits while you are editing a theme 
� Choose Save Edits from the Theme menu. 
 
To stop editing a theme and save your edits 
� Choose Stop Editing from the Theme menu. 
� Click Yes to the Save edit prompt. 
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3.0 HOT LINKING IN ARCVIEW 3.2 
 
A hot link is a functionality in ArcView that allows one to access data directly from a 
view.   The data format can be any of the following:  
 

• Text files 
• Images 
• Views 
• Tables 

• Charts 
• Layouts 
• Video clips 
• Scripts 

 
Supported image formats are: 
 
• X-Bitmap 
• MacPaint 
• Microsoft DIB ( Device - Independent Bitmap) 
• Sun raster files 
• XWD ( X Windows Dump Format) 
• GIF ( Graphic Interchange Format) 
• TIFF ( Tag Image File Format) 
• TIFF/LZW Compressed image data 
 
 
The Hot Link icon on the menu bar of a view activates the link.  
 
When you click on the feature with the Hot Link tool, ArcView opens the linked data 
source.  Each data source name becomes an attribute of a particular record. 
 
• Make the theme for the hot link active. 
• Identify the point, line or polygon feature to be hot linked. 
• Open the attribute table for that feature. 
• Select the record for that feature. 
• Create a field to hold the data 

� From the Tables menu, go to Table 
� Select Start editing 
� From Tables menu, Go to Edit 
� Select Add Field 
� Set parameters for the new field 

Name:  Image 
Type:   String 
Width : 30 (to hold the number of characters in the pathname for 

the image) 
� Click Close 
� Click Yes to the request to save edits. 
� Save edits  
� Exit Tables  
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Figure 17. Defining a hot link in a theme’s attribute table 

 
• From the attribute table of the feature theme, select the User-Id for the feature to 

which you wish to link the data. 
• On the same row as this User-Id, type in the pathname for the data. The pathname 

must include the full address of the location on the data on the particular drive.  An 
example of the full path name for hot linking an image is: 

 
c:\users\sal\watfall.tiff 
 

• If it is an image, type in also the extension for it, such as ‘.tif’ in the pathname. 
Since there is no default definition, the computer must find this location for the data 
every time the hot link is activated. 
 
• Go to View and make the theme active. 
• Open Theme menu 
• Select Properties 
• Choose Hot Links as the property.  
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•  The window below appears. 

 
  Figure 18. Setting up hot link properties 

 
• Change the field to read the pathname of the data. 
• Select Predefined Action from the pull-down menu, such as Link to Image File 
• Click OK 
• In the view, click on the Hot Link icon  
• Click on the feature that was linked and the image should be added to the view.  For 

point features make sure that the tip of the hot link icon is directly over the location of 
the feature. 

 
Figure 19.  Image linked to location of feature 
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4.0 CREATING THEMES IN ARCVIEW 3.2  USING GPS DATA. 
Positions of objects on the earth’s surface are measured in geographic coordinates. Global 
Positioning Systems (GPS) receivers can capture geographic coordinates.  These 
coordinates can be expressed either as degrees of latitude and longitude, or as pairs of x. 
y coordinates.  When these coordinates are saved in tabular format, ArcView allows you 
to create themes from such data.  
 
The tabular data format that ArcView supports are dBASE (.dbf), ASCII text files 
delimited with tabs or commas (.txt), and INFO tables. 
 
Locations stored in a tabular format are referred to as event locations or events. An event 
table is a table containing these events. Events allow you to map data that have 
geographic locations that are not in a spatial format, such as addresses and geographic 
coordinates in a table. 
 
GPS data must be in a Delimited Text ’.txt’  format so that ArcView can read it. 
 
To add tabular data with x, y coordinates to a map.  
� Make the Project window active 
� Choose Add Table from the Project menu. 
� Choose the type of file that you want to load from the List Files of Type dropdown 

list, in the dialogue box that appears. 

  
Figure 20. Dialogue box for adding a file to ArcView. 

 
� Navigate to the directory that contains the file you want to add. 
� Click on the file you want to add. 
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� Click OK.  The file is opened in your project.  The name of the file is listed in the 
Project window. 

 

 
Figure 21. File opened in Project window. 

 
� Open the View into which you want the data, or create a new one. 
� Go to the View menu and select Properties, to set the units for the x, y coordinates of 

the table. 
� Choose the units from the Map Units dropdown list that appears. 
� Click OK. 
� Choose Add Event Theme from the View menu. 
� Choose the name of your table from the dropdown list that appears in the dialogue 

box. 
� Select the name for the X field and Y field dropdown lists from your table. 
� Click OK.  A new theme is added to your view containing all the points defined in 

your table.  
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Figure 22. Dialogue box for Add Event Theme. 

 

 
Figure 23. A new theme added from GPS data. 

 
 
 
5.0 ATTRIBUTE DATA AUTOMATION USING MS ACCESS 
Attribute data describes the characteristics of spatial features.  In order to build a GIS, a 
digital database of the attributes of the spatial features needs to be collected and 
automated.  For example, the spatial feature, lake, may have the following attributes: 
Local name, maximum depth, water quality, biotic organisms, date of last water 
treatment, main uses.   
 
Attribute data are automated into Database Management Systems (DBMS) such as MS 
Access, DBASE IV, Oracle, FoxPro, DB2.  A DBMS provides the environment for the 
automation, updating, analysis, integration, and distribution of attribute data.  The 
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integration of a DBMS with the spatial functionalities of GIS enhances the capabilities of 
GIS as a spatial analysis tool. 
 
Sources of Attribute Data 
Attribute data may be newly collected in the field or obtained from existing records, 
registers, files, forms, cards and reports.  Once a spatial feature has been identified, the 
next step is to identify the attribute data that would be required for effective use of the 
spatial data in GIS analysis and manipulation.  This is followed by the identification of 
sources of this data.  If the data exists in analogue form, then steps should be taken to 
automate the data.  The process of automating the data is described below. 
 
This module will cover the following database topics: 

1. Creating a database in MS Access 
Creating a new table 
Adding attribute data to the table 

2. Connecting ArcView to an External Table 
Creating an SQL connection 
Joining an external table to a theme table  

 
5.1 CREATING A DATABASE IN MS ACCESS 2000 
MS Access is one of the more popular DBMS that ArcView supports.  In order to use MS 
Access to automate data, a blank database must first be created, using the following 
procedure: 

• Start MS Access 
• Click on Blank Access database 
• Click OK (See Figure 24) 
• Navigate to the directory in which you wish to save the database. 
• In the Filename input box, type in the name of your database, “Schools”  
• Ensure the database type is Microsoft Access.  
• Click Create. The new database is created. 
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Figure 24. Dialogue Box for creating a new database in MS Access 
 
5.1.1 Creating a Table 

Ms Access is an object oriented database and consists of a number of object such as: 
• Tables 
• Queries 
• Forms 
• Reports 
• Pages 
• Macros 
• Modules 
 

These objects rely on the data that is stored in tables for their functionality. For a 
description of each object type, please refer to Ms Access Help.  
 
Attribute data is stored in tables.  Each table should represent an entity and its attributes 
should consist of the descriptive elements required. 
 
5.1.2 Creating tables in Design View.   

• Double click on Create table in design view. 
• Using the information in Figure 25, enter the field name, data type and description 

for each of the five fields. 
 
A table consists of a field name, data type and appropriate description. Data types can be 
Number, Text, Date and Time.  Data types can be selected by clicking on the drop down 
list indicated by the down arrow in the cell. The description is utilized for the data 
dictionary. Object oriented databases also have field properties that afford users 
additional control over data entry. For further information, please see MS Access Help. 
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Figure 25. Designing aTable 

 
Data types should be carefully selected as appropriate to the data. Table I shows the data 
types in MS Access.  You should note that any data that will be calculated must be 
entered as a numeric data type.  
 
Table 1 – MS Access Data Types 
Data Type Example 
Text Default length of 50 characters, maximum 255 e.g.: address of school 

– 12 Picton Street, Port-of-Spain 
Memo Maximum length of 64,000 e.g. Notes on special conditions 
Number Numeric field, calculations rounded off e.g. enrollment - 1200 
Currency Numeric field, highly accurate calculations, no rounding e.g. cost of 

maintenance - $100,000.00 
Date / Time Date of construction – 2000/11/01 
Auto Number Access automatically assigns a unique sequential number to a field. 
Yes / No Used for a field that only one of two possible responses e.g. Did 

student pass or fail?  
Ole Object Allows for linking to objects such as pictures and documents 
Hyperlink Creates a field which allows input of a hyperlink address e.g. Web 

address of supplier 
Lookup wizard Creates a field that allows you to choose a value from another table or 

from a list of values e.g. Good, Fair and Poor as options for condition 
of school. 
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5.1.3 Adding records to the table 
• In the Database window, double click the new table that was created.  

 
• Enter five records as shown in Figure 26 by clicking on each cell and typing in the 

entry.  

 
Figure 26. Adding Records to an Access table 

 
Columns may be resized by dragging for convenient viewing. 
• Close the table 
• Select File, Exit 

 

Figure 27 shows commonly used data entry shortcut keys. 

Data Entry Shortcut Keys 

Action Keystroke 
insert current date Crtl + semicolon (;) 
insert current time  Crtl + colon (:) 
insert value from the same field in the previous record  Crtl + apostrophe (‘) 
add a new record  Crtl + plus sign (+) 
delete the current record  Crtl + minus sign (-) 

Figure 27.  Commonly used Data Entry Shortcut Keys 

 
5.2 Connecting ArcView to an External Database 
GIS data analysis often requires that non-spatial data be added to a project. The data may 
reside in a table or a query of another database. This requires that ArcView connect to the 
database and its specific tables or queries. 
 
An ‘ID’ field is generated by default when a new shape theme is created in ArcView. It is 
always defined as numeric.  The ‘ID’ field is the field that is common to both tables and 
is used as the join field.  To facilitate connecting to another table, it is critical that the 
‘ID’ field of the external table be defined and named exactly as the ‘ID’ field in the 
ArcView theme table to which it will be joined.  

• Make the ‘ID’ field the primary key of the table.  
• Right Click on the ‘ID’ cell. 
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• Select ‘Primary Key’. 
• Select File, Save and name the table “Capacity” 
• Click OK and close the table. A new table is listed in the database window. 

 
ArcView can connect in two ways: 

• The Project / Add Table Menu option 
• The Project / SQL Connect Menu option 

 

5.2.1 The Project / Add Table Menu Option  
This option allows the addition of .dbf , text delimited and INFO files to an ArcView 
project.  MS Excel spreadsheets may be exported as either .dbf or text delimited files and 
imported into ArcView.  Figure 28 illustrates the Project/Add Table dialogue box.  
 

   
Figure 28. Project/Add Table Dialogue Box 

 
5.2.2  SQL Connect Menu Option 
The SQL Connect function connects an ArcView project to a database utilizing 
Microsoft’s Open Database Connectivity (ODBC) standard. The ODBC driver for the 
database must be installed. The source name is setup in the ODBC Data sources manager 
in the Control Panel by the system administrator. ArcView should work with any 
database with an ODBC driver and database client software. Please refer to your 
operating system manual for instructions on installing an ODBC driver. 
 
SQL connect utilizes the ODBC source name for the database. SQL Connect allows 
external data to be accessed via SQL. The returned records are stored in an ArcView 
table. Records can be manipulated but not modified. 
 
5.2.3 Creating a Theme Table For Joining 

• Create a new point shapefile theme using the instructions from Section 1.1 in the 
Head –up digitizing module.  

• Name the new theme “Schools” 
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• Add five points to your theme 
• Enter the ID numbers 1,2,3,4,and 5 in the Theme table.  

 
Figure 29 indicates an example of this theme. 

      

Figure 29.  An Example of a Point Theme and Table 

 
5.2.4 Creating an SQL Connection 

• Select Project: SQL Connect 
• Navigate to the location of the MS Access database “Schools.mdb”.  
• Click OK 

 
As indicated in Figure30, tables available to ArcView will be listed in the Tables box. 

• Click on “Capacity” table created 
• Click on All Columns 
• Name output table in ‘Output Table:’ box 
• Click on ‘From:’ Box. Double click the name of your table in the Tables Box. 
• Click on Query. 
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Figure 30. SQL Query Dialogue Box 

5.2.5 Joining Tables 
The new table is added under Tables in the project window. There are now two tables 
listed in the Project window. 

• Open both tables in the table window. 
• Click on the ‘ID’ Field name on both tables. 
• Click on the Theme table to make it the active table.   
• Go to Table from the menu.  Select Join. 

 
Figure 31 shows the two tables to be joined using the Join selection. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 31.  Joining Tables 
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Figure 32 indicates the Theme table (Attributes of Schools) joined to the Capacity table. 
 
     

 
 
 
 
 

Figure32.  Joined Tables 

 
The joining of the Capacity table to the Theme table, Schools, now allows for the spatial 
querying of the data that was in the external table. 
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6.0 Data Management Requirements in GIS 
The development of a GIS involves the design and population of a database, which meets 
specific user requirements. It includes the transformation of data from existing formats to 
the formats required by specific GIS products and often requires the integration of 
different data. A successful GIS is one that will be utilized and expected to evolve over 
time. This requires a robust plan and database management system to support this 
development 
 
Figure 33 indicates that data management is one of the central elements of a GIS. It is an 
integral part of the information system that not only manages internal data manipulation 
but also the management of data input.  
 

          
Figure 33. Components of a GIS 

 
The success of a GIS is often measured by how accurately the design meets the 
requirements that were specified. However, users define a successful system as one 
which produces accurate and timely data in the formats required. To achieve this data 
management requirements must be considered and met. These include data identification 
and evaluation, classification and coding, data entry and validation, storage and access 
control, data maintenance and dissemination. These issues are part of a comprehensive 
database development plan, as shown in Figure 34. The management of data is not a 
single task but part of the continuous cyclic development of the database. These tasks 
themselves may be expected to evolve with the database and technology. 
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Figure 34. Database Development Plan 

 
6.1 Data Identification and Evaluation 
The identification and evaluation of system data is the primary stage in system 
development. Requirement analysis will identify data needs but the data sources must 
then be identified and evaluated. Key, reliable and current data sources that can form the 
foundation of the GIS must be identified. 
 
6.1.1 Data Identification 
In order to identify data requirements several questions must be considered: 
• What will the GIS be used for?  
• Who will the users be? 
• What information will be required and in what format will they be required? 
 
The data format currently being used should be identified and their usability examined. 
The evaluation of the existing data is aimed at determining their currency, quality, 
format, resolution and other restrictions to its use. 
 
6.1.2 Database Content and Structure 
At the conceptual stage it is important that all potential users come to a consensus on the 
features and attributes that should be included in the database. Data characteristics and 
the degree of intelligence required should be thoroughly evaluated and the maintenance 
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responsibility for database features should be clearly identified. Database needs should be 
prioritized and development phased. 
 
A principal task of GIS development is the determination of the database content. There 
is a need to establish: 
 
• Data features and attributes of interest to most or all users. 
• The most adequate data sources. 
• Data to be contributed by each participant. 
• The data to be shared by the GIS products. 
• The database design that will satisfy requirements. 
 
6.1.3 Data Sources 
Data may be collected from a variety of sources. The objective of the plan is to prevent 
surprises and avoid cost overruns. A thorough analysis of source data is required to 
prepare initial data conversion costs. The plan should include the matching of data needs 
to database design. The following issues should be considered:  
 
• Whether the source is primary or secondary. 
• The availability and reliability of metadata. 
• The format of the data. 
• The physical condition and location of hardcopy data. 
 
Source data must be evaluated in terms of their quality and completeness. Source data 
that has to be created must be identified and it is important to consider alternate sources 
of data such as aerial photography or satellite imagery. The prioritization of new data 
items and source decisions is essentially an economic decision. 
 
6.1.4 Data Collection Strategies 
The data collection strategy adopted is a function of data availability, cost and efficiency.  
The assembling of the data required by a GIS can be a significant exercise. The format 
and location of the data determine the degree of effort required. Data may be available in 
primary or secondary forms and in raw or compiled forms. Care should be taken when 
working with report formats to ensure that the tabulation details coincide with the detail 
level required of the GIS.  
 
6.1.5 Source Preparation  
Scrub is the manual preparation, edit verification and correction of a map or drawing 
prior to digitizing. Sources requiring scrub need to be identified and prepared 
appropriately for data conversion. A manual that addresses the details of the scrub plan 
should be prepared and scrub procedures should be driven by the database requirements. 
 
6.2 Data Integration 
The nature of a GIS requires that data be integrated from a number of different sources. 
The success of this integration affects the richness and accuracy of the data in the GIS. 



 

 53

Several integration issues must be recognized and successfully managed to achieve 
efficient and effective integration.  
 
Existing data may have varying characteristics such as scales, projections, datums, 
currency, levels of accuracy and resolution.  Metadata should be provided with each data 
collected to ensure that accurate information can be generated for the interpretation 
process. 
 
Data of different formats can be integrated into a GIS. These include vector files, 
attribute database files, text files, raster, video and scanned images, digital photographs, 
sound and Global Positioning Systems (GPS) data. 
 
The integration of multimedia data has served to increase the depth of GIS analysis. 
Multimedia Image Data include aerial and landscape photographs, infra-red images, 
satellite data and video based images. Theses images have the specific characteristics of 
Image_ID, Format (e.g. ‘.bmp’, ‘.tiff ’, ‘.avi’ ), Resolution (e.g. 300 dpi, 600dpi), Capture 
date, X and Y co-ordinates and Colour.  
 
Picture elements are identified by rows (X) and columns (Y) and the content of each 
picture element is represented by a colour, or a grey scale value. The easiest physical 
encoding technique is the bitmap (.bmp).  Sound and video images are stored digitally in 
“.avi” format. The limitation to widespread use of image data is the large amount of 
physical storage required. 
 
6.3 Data Classification and Codification 
Database attributes represent real world features. In order to efficiently create a database, 
it is necessary to classify and code data. A unique numbering system that supports 
classification and a unique identifier is assigned to each class.  Features are tagged with 
these numbers during the data automation process and it is on the basis of classification 
that features can be selected and manipulated.  Classification facilitates the queries and 
reports required of the system.  The efficient design of classification and coding relates 
directly to the level of efficiency of query and report generation. Coding should be 
determined in the context of system requirements. 
 
6.4 Data Entry Management 
Data entry management is an important element in the maintenance of data quality. It is 
also an important time and cost consideration that should not be underestimated. The time 
and cost of data entry relates to data source quality and the mode of data entry selected. 
The format, condition and location of data sources must be carefully considered. The 
mode of data entry employed must be appropriate to the data source and the availability 
of trained staff. 
 
6.4.1 Spatial Data Entry Modes  
A variety of data entry modes exist. Each mode has its strength and weakness and is 
particularly applicable to certain types of source data. The most cost efficient mode of 
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data entry should be chosen.  Cost efficiency must include time and staffing 
considerations. The choice of data entry options are listed below: 
 
a) Direct keyboard data entry is well suited to textual attribute data and map annotations 

in small to moderate volumes. Scanning with Optical Character Recognition (OCR) 
should be considered with large data volumes. 

b) The digitizing of hardcopy maps may be required in instances where digital maps are 
not available. It is applicable to small and moderate map conversion when skilled 
staff is readily available and time is not a constraint. 

c) Scanning and automated vectorization of maps, textual and image documents can be 
an extremely efficient method of data entry.  It may be costly depending on the 
volume being scanned.  The condition of the source map is a critical factor, which 
will relate directly to the amount of checking and cleaning required of the scanned 
document. 

d) The conversion of existing digital data is also an option, if it is necessary to convert 
digital data to another format.  Care must be taken to note the formats of sources and 
the conversion methodologies required for software compatibility. 

 
6.4.2 Attribute Data Entry Forms 
Data forms are utilized for the entry and retrieval of attribute data.  Data Entry Forms 
should exist in both hardcopy and digital format.  Raw data should be collated, coded and 
entered onto hardcopy forms that should then be verified and checked before digital 
entry.  Digital data entry should be done from these forms to facilitate speed, efficiency 
and accuracy. 
 
Digital data entry forms can integrate controls at the attribute level, which serve as a 
screening and data quality device. These controls relate directly to the classification and 
coding of the data.  The degree of control exerted by the data form will be a factor of the 
software being utilized. 
 
6.5 Data Verification 
Data verification consists of the processes of data quality control and quality assurance. It 
is dependent on the anticipated applications and output products. Data quality is a 
significant requirement in any automation project. It is an indication of how well the GIS 
data matches reality. It impacts on the data conversion method selected, cost and the 
confidence users will ultimately have in the GIS.  
 
Data quality is often a balancing act between user needs and cost. The realities of data 
conversion economics must be considered and the positional accuracy of source 
documents is a key issue, which must be examined. It is always desirable to improve the 
accuracy of source documents. A reduction in the allowable positional error can increase 
costs exponentially.  
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6.6 Standards 
The establishment and implementation of standards is critical to successful technical 
implementation.  Standards are a statement of quality.  They facilitate cost effective use 
of the GIS.  The more heavily used and complex a GIS is, the more critical the issue of 
standards.  They form the basis for data exchange and communication.  The development 
of standards requires extensive evaluation efforts and should be applied to the following: 
• Database design 
• Accuracy levels 
• Graphic presentation 
 
6.7 Quality Control 
Quality control ensures that the data standard determined for the GIS is applied and 
maintained. The type and extent of control will depend on the functionality of the 
software being utilized.  It should include the following elements: 
• Data checks before, during and after data entry. 
• Data entry form controls. 
• Data table design controls. 
• DBMS controls such as referential integrity. 
 
6.8 Quality Assurance 
The client should be able to determine the acceptability of data acquired. This process of 
data acquisition and automation must be documented and agreed to by all parties. In 
order to determine the acceptability of data, random sampling techniques are often 
utilized. Sampling may also be conducted by a neutral third party on the basis of 
established acceptance criteria. 
 
Quality assurance may be conducted using both manual and automated validation 
approaches. Manual quality assurance is designed to verify the accuracy and 
completeness of output products. Automated quality assurance utilises custom software 
designed to test the integrity of converted data. Quality assurance may also include field 
verification of data. 
 
6.8.1 Manual Validation 
Manual validation of source documents may consist of the following: 
• Absolute/relative positions must be within acceptable tolerances. 
• Feature annotation must correspond to the information provided on the source 

document and be in accordance with the graphic specifications. 
• Text offsets and orientations must be correct and be in accordance with the graphic 

specifications. 
• Feature annotation must be converted, formatted, and displayed in accordance with 

the GIS data conversion specifications. 
• Default attribute values must only be used in feature annotation when an acceptable 

value does not exist on the source documents. 
• Features depicted on the source documents and specified for conversion must be 

included on the check plot. 
• Graphical connectivity must be maintained in accordance with specifications. 
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• Feature representations must correspond to the source document representations and 
all must be present. 

• Features spanning multiple plots must be correctly edge matched. 
• Obsolete source record symbology must be correctly translated into GIS standard 

symbology in accordance with GIS data conversion specifications. 
 
6.8.2 Automated Validation 
Automated validation checks may consist of the following: 
• Each database record must represent a feature as specified in the GIS data conversion 

specifications documents  
• Each feature record must contain values for all required attributes. 
• Feature attributes must contain acceptable values. 
• Attributes containing calculated values must correspond to the values resulting from 

appropriate formula or algorithm. 
• All attributes for features requiring network connectivity must be logically consistent 

e.g. a 4-inch pipe cannot be connected to a 3-inch pipe without a reducer. 
• Each graphic element requiring connectivity must be connected e.g. in a soil coverage 

each boundary line between soil types should close to form a polygon. 
 
6.8.3 Field Verification  
Field verification is required to ensure the accuracy of the data.  Features located in the 
field and specified for data conversion must be included on a GIS check plot.  This check 
plot is the basis for field verification.  Field verification checks that the digital data is 
positioned on the GIS check plot within acceptable tolerances for relative and absolute 
accuracy.  Field observation ensures that features are classified correctly and feature 
displayable attribute values correspond to values observed or measured in the field. 
 
6.8.4 Assessing Data Quality 
The quality of data in a GIS may be assessed in general and specific terms as they relate 
to the cartographic and graphic elements.  The measures listed below are used to assess 
the general quality of the GIS: 
a) Completeness is the degree to which all features are included in the database. This is 

applied to graphic objects, attributes, annotation, connectivity and topology. It is 
more related to the source maps and records. 

 
b) Correctness consists of locational object information.   It considers the representation 

of object, attribute information and database relationship. 
 
c) Timeliness is a measure of the temporal correctness of the database. All data must be 

current or of a specified vintage. 
 
d) Integrity demonstrates and confirms the usability of the database. Graphic integrity 

examines the connection of lines, topology and connectivity of objects and attributes. 
It considers that records are correctly built and that there is no missing or duplicated 
data. 
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Cartographic data quality is assessed in terms of relative and absolute accuracy. Relative 
accuracy is a measure of an object’s position relative to another in terms of the maximum 
deviation between the two objects. Absolute accuracy considers how closely objects are 
positioned within an absolute reference frame. It is the maximum deviation of an object 
on a map vs. its true location on the earth’s surface. 
 
Graphic quality is assessed in terms of the legibility of data, consistency of graphic 
representation, aesthetics and the adherence to graphic standards such as symbols, line 
style, font size and placement. 
 
6.9 Data Storage and Retrieval 
A GIS database can be stored in a number of configurations and on a variety of storage 
media.  The database can be centralized or distributed.  A GIS consists of thematic layers 
and coverages, which may be stored as a single entity or tiled to reflect a chosen 
administrative boundary.  Similarly the data media for storage can be massive for bulk 
storage or form smaller units for convenient dissemination.  
 
Retrieval mechanisms are a function of the database design and storage choice.  They 
rely on database queries and their functionality and robustness will depend on the GIS 
software, database management systems and operating systems being utilised. 
 
6.9.1 Storage Structure 
The storage structure is related to structural design of the database. A centralised database 
design lends itself to bulk storage with massive hard drives, backup mechanisms and disk 
imaging.  Distributed databases pose significant challenges to GIS databases because of 
their cartographic size.  Data can be centrally stored and distributed over local or wide 
area networks but high data transfer speeds are critical to maintaining performance levels. 
Another option may be to distribute spatial data databases via CD-ROM and provide 
distributed network access to current attribute databases. 
 
The data may also be compressed to facilitate storage and transfer. Compression 
Techniques are utilized such as CCITT Group IV (an international compression 
standard), the use of Tag image file format (.tiff ) and Run length Encoded (.rle)  for line 
work. 

 
6.9.2 Storage Media 
A number of storage options exist such as hard drives, optical disks, magnetic tapes and 
removable disks.  The increasing size, retrieval speeds and reduced cost of hard drives 
have reduced the need to resort to other means of permanent data storage because of 
space constraints.  Optical disks may be more convenient because of their mobility and 
relative stability.  The increasing size of other removable disks such as zip disks offer an 
interesting option for smaller GIS databases because of their speed of access and ‘re-
writeability’. 
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6.9.3 Data Retrieval 
The linking of spatial and attribute tables expands the functionality of a GIS and 
facilitates efficient data storage and sharing. Spatial and attribute data are virtually linked 
to facilitate GIS analysis. This allows for attribute data to be maintained and distributed 
separately to the spatial data and accessed only when required. This has significant 
impact on permanent data storage requirements and is ideally suited to distributed 
systems. This type of design is supported by the development of Client Server 
architecture, the Internet and Active server pages (ASP). Server side processing greatly 
reduces the processing and storage demands on client machines. 
 
Data retrieval is based on the creation and execution of queries. The query language will 
vary with the software being utilised. In some cases the attribute data may be externally 
stored within a separate database management system and an interface connection will 
have to be created.  Most GIS will support the creation of permanent database 
connections and in particular SQL connections. 
 
 
6.10 Access Methods and Control 
Access control is required to protect information from unauthorized or accidental 
modification, destruction, disclosure and use. Data collection is an investment and the 
need for security increases as the value of information is recognized by the organization. 
This is particularly true in the present IT environment with the need for daily virus 
protection.  In order to implement access control it is necessary determine the following 
data access issues: 
• The levels of data access required. 
• The allocation of users to access levels. 
• The identification of restricted data and the method of distribution that will apply. 
• The identification of potential threats 
• The mechanisms available for access control 
• A determination of data access costs. 
 
The risk management view of security evaluates access control and the need for security 
in terms of the following: 
 Confidentiality - level of access 
 Integrity  - wholeness, completeness 
 Availability  - back ups 
 Utility   - usefulness 
 Authenticity  - accuracy, correctness of information 
 
There are two dimensions to security, system security and data security. System security 
relies on technology and is a function of software capabilities. Data security is established 
through data access policy.  
 
Several security mechanisms can be employed. Username, passwords, fingerprints or 
voice can be used to determine authorization to a specified level of access, data or 
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services. Access Audits should be run on a regular basis as a security measure and to 
monitor usage of the database. 
 
6.11 Updating and Maintenance Procedures 
The updating and maintenance of a GIS is a critical issue. The currency of data will 
ensure the value and continued use of the system. Updating and maintenance procedures 
should be designed in a feasible manner that take into consideration the resources of 
participating agencies. It should be practical and applicable. The interest of participants in 
database maintenance will vary and it is impossible to maintain a central database at 
different rates. The simplest solution is the sharing of a centrally maintained land (LAN?) 
base with participants maintaining their own database layers. 
 
Updating and maintenance procedures should consider which participants have specific 
responsibility for maintenance, data currency and updates. The procedures should 
consider if responsibilities relate to all data or to a specified subset of data.  If so, it must 
clearly identify the subsets and participants that are responsible for maintaining the 
portions of the database. The issue of a participant abandoning this responsibility must be 
examined and a consensus of opinion reached as to procedures in this instance. The 
procedures must be clearly determined, agreed to and documented.  
 
 
6.12 Data Dissemination and Distribution 
The dissemination and distribution of data incurs legal liability and data rights on the part 
of the distributing agency. GIS data is an asset to organizations and has come to be 
considered a property, since a property data can be owned, held or kept from others.  
 
The design of the GIS having a number of participating agencies requires that rights and 
liabilities be determined. It is possible in a distributed system to have a number of 
agencies each responsible for its own database, which it shares with the larger entity. In 
such scenarios liabilities and rights must be clearly determined by all parties prior to the 
implementation of the system. The management of these activities requires that these 
liabilities and rights are considered and an appropriate dissemination policy determined.  
A data dissemination policy should determine the following: 
• The distributing agency or unit. 
• The data items that should be distributed. 
• The medium of distribution. 
• A pricing policy (if necessary) 
 
 
6.13 Data Distribution Options 
Data distribution may be undertaken as a public service or for commercial purposes. The 
private sector may act as a distribution or value added agent. There are a number of 
distribution options, some of which are listed below:  
• Each department distributes own data to customers 
• A single value-added agency - one-stop shopping 
• Multiple value-added agencies for specific markets 
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• Multiple value-added agencies for specific data 
 
 
6.14 Liability 
The provision of land-related data exposes the provider to liability for losses incurred by 
the user as a result of inaccuracies in the data. Data management must consider accuracy 
and quality issues inherent in data collection and update, data entry, data model and scale, 
the accuracy of software and hardware, paper and plotting accuracy. The provider may be 
liable for breach of contract, delivery timetables and negligence. The provider may  also 
be liable for accuracy and non-performance and it is therefore necessary to include an 
accuracy disclaimer with data provided (where necessary). 
 
In order to effectively manage data liability the following issues must be considered: 
• Definition of public records and access issues  
• Policy on freedom of information, costs of public information and data resale 
• Copyright laws 
• Digital data security issues 
• Map maintenance liabilities 
 
 
6.15 Data Ownership 
Data is an asset that can be owned. However, because of the digital nature of data special 
care must be taken to specify and protect this ownership. The data dissemination policy 
should address ownership concerns. An organization may hold data on behalf of the 
wider community or may also hold data in a custodianship.   
 
Copyright may be used to protect the investment of organizations in the database. It 
assures that the creators retain the sole right to its use. An external copyright can prevent 
distribution among participants. Licensing can establish a contractual relationship 
between participants and the purchasers of data. 
 
The nature of some projects requires ownership and operation of a common data centre. 
Asset ownership should be clearly specified and if payments are required they should be 
fully scheduled. Data ownership and maintenance issues must be carefully detailed. 
 
 
6.16 Pricing 
The pricing of data is an economic issue, which often takes on political overtones if the 
data agency is a public agency.  The core issue sometimes border on cost recovery. 
Pricing strategies are often a trade-off that balances public opinion and some measure of 
cost recovery.   The legal issue of the right to freedom of information must be considered. 
It may be that the only costs that can legally be recovered are costs incidental to the 
supply of the data to the end user.  Cost can be determined on the basis of a number of 
parameters. These may include the following:  
• Volume of data supplied 
• Extent of Coverage: Parish / County / Country 
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• Form of product:  list / print / plot / chart 
• Use of information: public benefit / profit making 
• Market value 
• Reciprocity arrangements 
• Legislative or statutory requirements 
• Precedent 
 
A number of cost recovery options exist and are listed below: 
• Direct cost recovery (labour & material only) 
• Incremental cost recovery  
• Partial cost recovery  
• Costs of system development / data maintenance / data distribution 
• Market value pricing (supply/demand) 
• Full cost recovery (HW/SW, data, training, salary) 
 
 
 
 
References 
Environmental Systems Research Institute. 1996. ArcView GIS.  Environmental Systems 
Research Institute , Redlands, CA, USA. 
 
Montgomery, G.E., and Schuch, H. 1993. GIS Data Conversion Handbook. GIS World 
Books.



 

 62

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

APPENDIX 1 
 
 

The notes in Appendix I are taken from 
 the on-line Help function of ArcView 3.2.  
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1. OVERVIEW OF EDITING THEMES 
 
ArcView allows you to edit a theme that is based on an ArcView shapefile if you have 
file write permission on the shapefile.  
 
To make a shapefile theme editable 
• Make the shapefile theme active. 
• Choose Start Editing from the View’s Theme menu. ArcView allows you to edit only 

one theme in a view at a time. If you choose Start Editing on a theme while you are 
editing another theme, you will be prompted to save your edits on the theme you were 
previously editing before editing on the second theme is enabled. 

 
A dashed line around the theme’s check box in the Table of Contents indicates that you 
can edit that theme. 
 
To undo and redo edits 
Choose Undo Feature Edit from the Edit menu to undo the last edit you made to the 
shapefile. Choosing this option repeatedly enables you to successively undo all the edits 
you made since you started editing. Undo Feature Edit undoes changes to the feature 
geometry in the shapefile and the corresponding changes to the feature attribute table. 
The Redo Feature Edit option let you re-apply the changes. 
 
To save your edits and continue editing 
Choose Save Edits from the Theme menu to save all edits made to the theme during the 
current edit session. Once you save the edits, you can continue to edit the theme but you 
are not able to undo or redo any edits that were made prior to choosing Save Edits. 
 
To save your edits out to a new theme 
Choose the Save Edits As option from the Theme menu if you want to save your edits out 
to a new shapefile rather than changing the original shapefile. The edited version of the 
original theme will be written out to the new shapefile, editing will be disabled on the 
original theme, and the edits will not be written to the original shapefile. The new 
shapefile will be added to the view as a theme, the same editing environment and legend 
will be set up for this theme, and editing will be started on the new theme automatically. 
Now any edits you do will be to the new theme.  
 
To stop editing a theme and commit your edits 
Choose Stop Editing from the View’s Theme menu to disable editing on the theme. You 
will be prompted to save your edits.  
 
Note: You cannot edit the features of a multipoint shapefile theme. Start Editing is 
disabled if the theme you want to edit contains multipoint features. To check if a theme is 
a multipoint theme, see the Shape field in the theme’s attribute table. However, you can 
edit the values in its attribute table. 
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2. EDITING SHAPES USING SHAPE PROPERTIES 
The Shape Properties dialog allows you to view or edit the properties of the selected 
graphic or feature in your view.  
 
To view or edit the properties of a shape:  
1. Select a feature or a graphic in your view 
2. Right-click on the shape and select Shape Properties from the pop-up menu 
3. Select the Vertex in the list you want to change, or add a new vertex after. 
4. Click Add, Edit, or Delete. 
5. Click OK to commit the changes to the shape. 
 
 
3.  EDITING POINT THEMES 
There are many ways to edit point themes. What do you want to do? 

• Delete point features 
• Cut and paste point features 
• Move point features 

 
Deleting features 
To delete features 
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the feature or features you want to delete. 
3. Press the DELETE key. 
 
The features are removed from the theme, and the corresponding records in the feature 
attribute table are automatically removed. 
 
Cutting and pasting features 
You can cut features from one theme and paste them into another theme. 
To cut and paste features 
1. If the theme you want to cut features from is not already in edit mode, make the 

theme active and from the Theme menu, choose Start Editing. 
2. Use the Pointer tool to select the features you want to cut. 
3. From the Edit menu, choose Cut Features to cut the features to the clipboard..  
4. Start Editing on the theme you want to paste the features into. You will be prompted 

to save edits on the first theme. 
5. From the Edit menu, choose Paste. 
 
It is not advisable to cut from a theme in one view and paste into a theme in a different 
view because the two views may have different projections or map units. ArcView places 
features based on their coordinates and in the above case, the coordinate spaces for the 
two views may not be the same. 
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Moving features 
To move features with the mouse  
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the feature or features you want to move. 
3. Press and hold the mouse button within a selected feature or features, then drag to a 

new location. A faint outline of the selection follows the mouse movement; the 
feature re-draws in the new location once the mouse button is released. 

 
 
4.  EDITING LINE THEMES 
There are many ways to edit line themes. What do you want to do? 

• Create new line features 
• Delete line features 
• Cut and paste line features 
• Move line features 
• Resize line features 
• Reshape line features 
• Split line features 
• Merge line features 

 
Deleting features 
To delete features 
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the feature or features you want to delete. 
3. Press the DELETE key. 
 
The features are removed from the theme, and the corresponding records in the feature 
attribute table are automatically removed. 
 
Cutting and pasting features 
You can cut features from one theme and paste them into another theme. 
To cut and paste features 
 
1. If the theme you want to cut features from is not already in edit mode, make the 

theme active and from the Theme menu, choose Start Editing. 
2. Use the Pointer tool to select the features you want to cut. 
3. From the Edit menu, choose Cut Features to cut the features to the clipboard..  
4. Start Editing on the theme you want to paste the features into. You will be prompted 

to save edits on the first theme. 
5. From the Edit menu, choose Paste. 
 
It is not advisable to cut from a theme in one view and paste into a theme in a different 
view because the two views may have different projections or map units. ArcView places 
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features based on their coordinates and in the above case, the coordinate spaces for the 
two views may not be the same. 
 
Moving features 
To move features with the mouse  
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the feature or features you want to move. 
3. Press and hold the mouse button within a selected feature or features, then drag to a 

new location. A faint outline of the selection follows the mouse movement; the 
feature re-draws in the new location once the mouse button is released. 

 
Resizing features 
To resize a feature with the mouse  
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the feature you want to resize. 
3. Click the mouse on a handle and drag. The corner handles provide stretching that will 

maintain the aspect ratio (i.e. if you stretch a square from one of its corner handles it 
will still be a square when you are done). The side handles allow you to resize in the 
horizontal or vertical directions. A faint outline of the feature being stretched follows 
the mouse movement, and the feature is redrawn when the mouse button is released. 

 
Reshaping lines 
You can use the Vertex Edit tool to reshape a line by moving, adding, or deleting 
vertices. When you edit a line, you can choose to preserve topology, or not, by the way in 
which you select the feature: 
When you select a single line, any edits you make to the vertices will affect only that line.  
When you select a line segment common to two lines, any edits you make to the vertices 
will affect both lines.  
When you select a node common to two or more lines, any edits to that node will affect 
all the lines that contain that node. 
 
To move a vertex with the Vertex Edit tool 
Place the cursor on the vertex you want to move. When the cursor appears as a crosshair, 
hold down the left mouse button and drag the vertex to the new position.  
 
To add a new vertex with the Vertex Edit tool 
Move the cursor to the position on the line where you want the new vertex. When the 
cursor appears as a target, click the left mouse button. 
 
To delete a vertex with the Vertex Edit tool 
Place the cursor on the vertex you want to delete. When the cursor appears as a crosshair, 
press the DELETE key on the keyboard. 
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To reshape a single line 
1. Click the Vertex Edit tool. 
2. Click on the line. A hollow, square vertex handle appears at each vertex of the line.  
3. Now when you move, add, or delete vertices, only the single line will change. 
 
To reshape a segment common to two lines 
1. Click the Vertex Edit tool. 
2. Click on the common line segment. Square vertex handles will appear at each vertex 

of the shared segment, and round anchors will appear at the vertices at each end of the 
common segment.  

3. Now when you move, add or delete a vertex, both lines will change. 
 
To move a node that is common to a number of lines 
1. Choose the Vertex Edit tool. 
2. Click on the node that’s common to two or more lines. A square vertex handle will 

appear at this node and round anchors will appear on the next closest vertex on each 
line.  

3. Now when you move the common node, all lines, which share this node, will change. 
 
Splitting line features 
In ArcView, you can use the Line Split tool to create a line that gets split wherever it 
crosses another line, and also splits all lines it crosses.  
 
To split line features 
If the theme is not already in edit mode, make the theme active and from the Theme 
menu, choose Start Editing. 
1. Click the Drawing tool palette and in the list of tools that pops down, click the Line 

Split tool.  
2. In the view, click the left mouse button where you want the line to start, click each 

vertex, and then double-click the final vertex. The line you draw with the Line Split 
tool must cross over at least one other line for any new features to be created. Both 
the existing line and the new line are split into two separate lines at the point where 
they cross. (The same new line can cross more than one existing line if you want to 
split a number of lines at once). 

 
When a feature is split with the Line Split tool, the record of that feature is removed from 
the theme’s feature attribute table and two new records are added to the table to represent 
the new features. If you want to specify how the data in  the original record is handled 
when you split line features, you can set attribute update rules for each field in the table. 
 
Merging line features 
If you have a group of lines that you want to merge into one line, use the Union Features 
option. Union Features returns the union of the selected features to create a single feature. 
If two lines meet at exactly the same point, one continuous line will result. Otherwise, the 
result is one feature with multiple parts. If the line features overlap, the overlapping 
segment is not removed. 
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To merge lines 
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the lines you want to merge. 
3. From the Edit menu, choose Union Features. 
 
When a set of features is merged with Union Features option, the records of those 
features are erased from the feature attribute table and one new record is added to the 
table to represent the new feature. If you want to specify how the data in the original 
records is handled when you merge line features, you can set attribute update rules for 
each field in the table. 
 
 
5.  EDITING POLYGON THEMES 
There are many ways to edit polygon themes. What do you want to do?  

• Delete polygon features 
• Cut and paste polygon features 
• Move polygon features 
• Resize polygon features  
• Reshape polygon features 
• Split polygon features 
• Merge polygon features 
• Create doughnut polygons 
• Remove area of overlap between polygons 
• Obtain the intersection of polygons 

 
Deleting features 
To delete features 
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the feature or features you want to delete. 
3. Press the DELETE key. 
 
The features are removed from the theme, and the corresponding records in the feature 
attribute table are automatically removed. 
 
Cutting and pasting features 
You can cut features from one theme and paste them into another theme. 
To cut and paste features 
1. If the theme you want to cut features from is not already in edit mode, make the 

theme active and from the Theme menu, choose Start Editing. 
2. Use the Pointer tool to select the features you want to cut. 
3. From the Edit menu, choose Cut Features to cut the features to the clipboard.  
4. Start Editing on the theme you want to paste the features into. You will be prompted 

to save edits on the first theme. 
5. From the Edit menu, choose Paste. 
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It is not advisable to cut from a theme in one view and paste into a theme in a different 
view because the two views may have different projections or map units. ArcView places 
features based on their coordinates and in the above case, the coordinate spaces for the 
two views may not be the same. 
 
Moving features 
To move features with the mouse  
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the feature or features you want to move. 
3. Press and hold the mouse button within a selected feature or features, then drag to a 

new location. A faint outline of the selection follows the mouse movement; the 
feature re-draws in the new location once the mouse button is released. 

 
Resizing features 
To resize a feature with the mouse  
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the feature you want to resize. 
3. Click the mouse on a handle and drag. The corner handles provide stretching that will 

maintain the aspect ratio (i.e. if you stretch a square from one of its corner handles it 
will still be a square when you are done). The side handles allow you to resize in the 
horizontal or vertical directions. A faint outline of the feature being stretched follows 
the mouse movement, and the feature is redrawn when the mouse button is released. 

 
Reshaping polygons 
You can use the Vertex Edit tool to reshape a polygon by moving, adding, or deleting 
vertices. When you edit a polygon, you can choose to preserve topology, or not, by the 
way in which you select the feature: 
When you select a single polygon, any edits you make to the vertices will affect only that 
polygon.  
When you select a shared boundary between two polygons, any edits you make to the 
vertices will affect both polygons.  
When you select a node common to two or more polygons, any edits to that node will 
affect all the polygons that contain that node. 
 
To move a vertex with the Vertex Edit tool 
Place the cursor on the vertex you want to move. When the cursor appears as a crosshair, 
hold down the left mouse button and drag the vertex to the new position.  
 
To add a new vertex with the Vertex Edit tool 
Move the cursor to the position on the line where you want the new vertex. When the 
cursor appears as a target, click the left mouse button. 
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To delete a vertex with the Vertex Edit tool 
Place the cursor on the vertex you want to delete. When the cursor appears as a crosshair, 
press the DELETE key on the keyboard. 
 
To reshape a single polygon 
1. Click the Vertex Edit tool. 
2. Click inside the polygon. A hollow, square vertex handle appears at each vertex of the 

polygon’s boundary.  
3. Now when you move, add or delete vertices, only the single polygon will change. 
 
To reshape a common boundary between two polygons 
1. Click the Vertex Edit tool. 
2. Click on the common boundary. Square vertex handles will appear at each vertex of 

the shared boundary and round anchors will appear at the vertices at each end of the 
common boundary.  

3. Now when you move, add or delete a vertex, both polygons will change. 
 
To move a node that is common to a number of polygons 
1. Click the Vertex Edit tool. 
2. Click on the node that is common to two or more polygon features. A square vertex 

handle will appear at this node, and round anchors will appear on the next closest 
vertex on each polygon. 

3. Now when you move the common node, all polygons, which share this node, will 
change. 

 
Splitting polygon features 
When you are editing polygons, you can use the Polygon Split tool to draw a line across a 
polygon to split it into separate polygons. For example, to create 10 adjacent land parcels, 
you can create one polygon that represents the outer boundary of all the parcels, and then 
use the Polygon Split tool to draw the boundary lines between them to split the polygon 
into 10 separate polygons. This capability also makes it easy to modify existing polygons. 
For example, to make a polygon smaller you can use the Polygon Split tool to simply 
split off the unwanted part, select it, and then delete it. 
 
To split polygon features 
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Click the Drawing tool palette and in the list of tools that pops down, click the 

Polygon Split tool. (If this tool is dimmed out, your theme is not currently in edit 
mode. Choose Start Editing from the Theme menu). 

3. Draw a line across the polygon you want to split. To draw the line, click where you 
want the line to start, click each vertex along the line, then double-click the final 
vertex. You can overshoot the boundary of the polygon you are splitting. (The same 
line can continue through more than one polygon if you want to split a number of 
polygons at once).  
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When you have finished drawing the line, ArcView automatically splits the polygon 
along the line your drew, and removes any overshoots from the line 
When a feature is split with the Polygon Split tool, the record of that feature is removed 
from the theme’s feature attribute table and two new records are added to the table to 
represent the new features. If you want to specify how the data in the original record is 
handled when you split polygon features, you can set attribute update rules for each field 
in the table. 
 
Merging polygons 
If you have a group of polygons that you want to merge into one polygon, use the Union 
Features option. Union Features option returns the union of the selected features to create 
a single feature. If the selected polygons share a common boundary, the common 
boundary is removed to create a single polygon. If the selected polygons overlap, the 
boundaries of the overlap are removed to create one polygon. If the polygons are not 
adjacent or overlapping, the result is one feature with multiple parts.  
 
To merge polygons 
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the polygons you want to merge.  
3. From the Edit menu, choose Union Features.  
 
When a set of features is merged with the Union Features option, the records of those 
features are removed from the theme’s feature attribute table and one new record is added 
to the table to represent the new feature. If you want to specify how the data in the 
original records is handled when you merge polygon features, you can set attribute update 
rules for each field in the table. 
 
Creating doughnut polygons 
If you have a polygon and want to create a hole inside it (make it into a doughnut 
polygon) use the Combine Features option. With this option, the polygons you select are 
merged, but any overlap between the polygons is removed from the resulting polygon. 
 
To create doughnut polygons 
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. On top of the polygon that you want to make into a doughnut, use the Polygon, 

Circle, or Rectangle tool to draw a smaller polygon representing the area you want to 
cut out. 

3. Use the Pointer tool to select both of the polygons.  
4. From the Edit menu, choose Combine Features. 
 
Note:  If your selected polygons do not overlap, Combine Features option behaves the 
same way as Union Features. 
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Removing area of overlap between polygons 
If you have two overlapping polygons and want to remove the area of overlap, you can 
subtract one polygon from the other using the Subtract Features option. The polygon on 
top gets subtracted from the polygon on the bottom, so the portion of the bottom polygon 
that is overlapped by the top polygon is removed, and the top polygon remains 
unchanged. 
Suppose you are adding a new polygon to your theme and one of the existing polygons 
extends into the area where the new polygon should be. You can draw the new polygon, 
extending on top of the existing polygon, and then use Subtract Features to remove the 
area of overlap from the existing polygon.   
 
To remove an area of overlap between polygons 
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Draw the new polygon, partly overlapping an existing polygon. 
3. Use the Pointer tool to select the new polygon and the existing polygon containing the 

area you want to subtract. (Subtract Features only works on two selected polygons at 
a time). 

4. From the Edit menu choose Subtract Features. 
 
Note: If you want to reverse the order of the operation, that is, subtract the bottom 
feature from the top feature, hold down the SHIFT key as you choose Subtract Features 
from the menu. 
 
You can also use the Subtract Features option to create an island polygon (a polygon that 
is totally surrounded by another polygon but which does not overlap the polygon it is 
surrounded by). To create an island polygon, draw the polygon on top of the polygon that 
it is surrounded by, select both polygons, and choose Subtract Features. 
 
Obtaining the intersection of polygons 
Use the Intersect Features option if your theme contains several polygons that overlap 
and you are only interested in the area that is shared by the overlapping polygons. This 
creates a new polygon from the area common to the overlapping polygons, and removes 
all the original polygons. 
 
To obtain the intersection between polygons 
1. If the theme is not already in edit mode, make the theme active and from the Theme 

menu, choose Start Editing. 
2. Use the Pointer tool to select the polygons you want find the intersection of. In this 

example, two polygons have been selected. 
3. From the Edit menu choose Intersect Features. 
 
 
 
 

 
 


